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Document Disclaimer 
Any change or modification not expressly approved by CATC voids the user’s authority to operate this 
equipment. 

The information contained in this document has been carefully checked and is believed to be reliable. 
However, no responsibility can be assumed for inaccuracies that might not have been detected. 
CATC reserves the right to revise the information presented in this document without notice or penalty. 
Trademarks and Servicemarks 
CATC, NetMate, Advisor, Chief, USB Advisor, USBTracer, USBTrainer, FireInspector, Inspector, 
Detective, Traffic Generator, BusEngine, USB4DOS, UPT, UPT2, HPT, and UHT are trademarks of 
Computer Access Technology Corporation.  
Microsoft, Windows, and Windows NT are registered trademarks of Microsoft Inc. 
All other trademarks are property of their respective companies. 
Copyright 
Copyright ©  2002, Computer Access Technology Corporation (CATC); All Rights Reserved. 
This document may be printed and reproduced without additional permission, but all copies should contain 
this copyright notice. 
FCC Conformance Statement 
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed and used in accordance with the instruction 
manual, can cause harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user will be required to correct the 
interference at his own expense. The end user of this product should be aware that any changes or 
modifications made to this equipment without the approval of CATC could result in the product not 
meeting the Class A limits, in which case the FCC could void the user's authority to operate the equipment. 
EU Conformance Statement 
This equipment complies with the EMC Directive 89/336/EEC and its associated amendments. It has been 
tested and found to comply with EN55022:1998 Class A (CISPR 22:1998) and EN55024:1998 (EN61000-
4-2:1995, EN61000-4-3:1995, EN61000-4-4:1995, EN61000-4-5:1995, EN61000-4-6:1995, EN61000-4-
8:1993, EN61000-4-11:1994). In a domestic environment this product can cause radio interference in 
which case the user might be required to take adequate measures. 
BSMI Class A Warning Notice 

 
 Part Number 730-0025-00 
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1 OVERVIEW 
This manual applies to the USB2.0 4-Port Tester (UPT2-4) and the USB2.0 8-Port Tester 
(UPT2-8). When no distinction is required, the unit is referred to as the USB 2.0 Port 
Tester, Port Tester, or UPT2.  
 
The CATC USB 2.0 Port Tester (UPT2) is a USB test tool designed for use on the 
production line to test the USB ports on PC motherboards or stand-alone USB hubs, 
according to the USB 1.1 and 2.0 specifications. UPT2 supports USB host controller 
implementations for the UHCI, OHCI and EHCI.  The UPT2 tool consists of a hardware 
box that provides connections for ports under test, and a DOS application that controls 
the test process by communicating directly with the PC USB Host Controllers. 
 

1.1 CATC UPT2 Features 
The features of UPT2 are: 
¾ DOS-based software program verifies functionality of the USB system under test 
¾ Simple DOS-based user interface to control test operation and configuration 
¾ Supports UHCI, OHCI and EHCI USB host controller implementations 
¾ Testing of four USB root ports in 10 to 30 seconds or eight USB root parts in 40 

to 60 seconds 
¾ Τests low-, full- and high-speed port operation as applicable for the port type 
¾ Tests internal or stand-alone USB hub 
¾ Εnclosure-mounted LEDs for visual status 
¾ Can be incorporated into customer system test platforms 
¾ Τested for compliance with the USB 1.1 and 2.0 specification 
¾ Uses BIOS allocated memory addresses to support EHCI and OHCI controllers 

connected on Southbridge PCI architectures. 

1.2 CATC UPT2 Port Tests 
The UPT2 application automatically detects the port types and based on test configuration 
settings executes the correct tests for the connected ports. The available tests are:  
¾ Connection Test 
¾ Disconnection Test 
¾ Control Transfer Test 
¾ Bulk Data Transfer Test 
¾ Interrupt Data Transfer Test 
¾ Isochronous Data Transfer Test 
¾ VBUS Voltage Test 
¾ D+/D- Voltage Test 
¾ Selective Suspend/Resume Test 
¾ Device Generated Remote Wakeup Test 
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The table below shows the UPT2 capabilities contrasted with CATC’s previous USB port test 
products. 

 
Support UPT2 UPT HPT 
Host Controller  UHCI , OHCI, EHCI UHCI, OHCI UHCI, OHCI 
Speed Capability Low-, Full- and High-

Speed 
Low- and Full-

Speed 
Low- and Full-

Speed 
USB Hub Tests Yes Yes No 
Connection Test Yes Yes Yes 
Disconnection Test Yes Yes Yes 
Control, Bulk, 
Isochronous, and 
Interrupt Data Transfer 
Tests 

Yes Yes No 

Interrupt Transfer Test Yes Yes No 
Isochronous Transfer 
Test 

Yes Yes No 

VBUS Voltage Test Yes Yes No 
D+/D- Voltage Test Yes Yes No 
Selective 
Suspend/Resume Test 

Yes Yes No 

Device Generated 
Remote Wakeup Test 

Yes Yes No 

 

1.3 Stand-Alone Hub Testing 
The UPT2 system is designed to test the one upstream port and up to 8 of the downstream 
ports of the hub under test. See the “Installing UPT2” section for details about how to 
setup the hardware for testing external hubs.  
 
The software provides at the end of the test listing of on-screen results. If all tests were 
successful, the software declares the hub under test to be functional. In case of a faulty 
device, the software provides a detailed description of the test results in a text file. It also 
accumulates the failure rate for the entire testing day in a file.   
 
The UPT2 performs the following tests on hub ports: 

• Connection Test 

• Disconnection Test 
• Control Transfer Test 
• Bulk Data Transfer Test 
• Interrupt Data Transfer Test 
• Isochronous Data Transfer Test 
• VBUS Voltage Test 
• D+/D- Voltage Test 
• Selective Suspend/Resume Test 
• Device Generated Remote Wakeup Test 
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The hub-specific tests conducted by UPT2 are: 
• Hub power switching 
• Hub over current 
• Hub generated remote wakeup 
• Downstream propagation of remote wakeup 

1.4 System Components 
The DOS-based UPT2 application communicates with the UPT2 box via the USB host controllers 
on the PC motherboard. For each port, the UPT2 software checks for proper operation in low-, 
full- and high-speed modes as applicable for the port type. When all tests are successful, the 
software declares the unit to be functional. The CATC Tracer/Trainer, Advisor and Chief USB 
Bus & Protocol Analyzers can be used to debug and rework units that fail these tests. 
 
The CATC UPT2 package includes these components: 

¾ A sturdy metal box housing the UPT2 electronic test circuitry based on the Cypress FX2 
USB 2.0 controller. 

¾ An AC-to-DC converter. 

¾ Four USB cables (UPT2 – 4) or eight USB Cables (UPT2 – 8). 

¾ A diskette containing the CATC UPT2 DOS application program file UPT2.EXE, and a 
README.TXT file that provides useful information about the product. 

¾ The front of the UPT2 – 4 box has four female B-type USB connectors and two LEDs. 
The UPT2 – 8 box has 8 female B-type USB connectors and two LEDs. 

¾ The rear of the UPT2 box has a +9V DC @ 1000mA power connector. 
 
The USB connectors (marked as CH1 through CH4 for UPT2 – 4 or as CH1 through CH8 for 
UPT2 – 8) connect the UPT2 box to the unit under test. The power connector powers the box 
from the AC-to-DC power converter. When power is applied, the red LED (marked PWR) is 
illuminated. The green LED (marked STATUS) is a status indicator that blinks rapidly to indicate 
that the UPT2 on-board microcontroller is functioning properly. 

1.5 Connectors and Cables 
All connectors have a limited life (i.e. number of connect/disconnects before failure). When 
testing multiple units, be sure to plug and unplug cables at the unit under test side and not at 
the UPT2 box. Forceful or otherwise improper connection and disconnection of USB cables can 
damage the cables and connectors on the CATC UPT2 box or the USB system.  
 
Note: The CATC Warranty specifically excludes damage caused by product misuse. There is 
generally no need to disconnect the B-type USB connectors from the UPT2 box. There is also no 
need to power down the UPT2 box between tests. 
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2 Installing UPT2 
The UPT2 installation involves setting up the hardware, installing the software and creating a 
configuration file. 

2.1 Installing the Hardware 
The following describes installation procedures for installing hardware for testing ports 
on a host PC and hardware setup for testing an external hub and hub ports. ] 

2.1.1 Testing PC Ports 
This hardware setup is for testing the ports on the host PC. 

Step 1 Connect the DC plug of the AC-to-9V DC @ 1000mA power converter to the 
+9V receptacle of the CATC UPT2 box. 

Step 2 Plug the AC power cable into an outlet. 

Step 3 Connect a USB cable between the USB connector labeled CH1 on the UPT2 box 
and a USB port of the unit under test. 

Step 4 If the unit has additional ports, use other USB cables to connect them to the USB 
connectors labeled CH2, CH3, and CH4 on the UPT2 – 4 or CH2, through CH8 
on the UPT2 – 8 box as needed. 

Note: Channels must be used in order. Channels cannot be skipped. 

The CATC UPT2 hardware is now ready for operation. 

2.1.2 Testing External Hubs and Ports 
This hardware setup is for testing external hub and hub ports. When applying tests for 
hub power switching, hub generated remote wakeup and hub propagation of remote 
wakeup, at least two hub downstream ports must be connected to the UPT2. 

Step 1  Connect the DC plug (s) of the AC to 9V DC @ 100mA power converter to the 
+9V receptacle of the UPT2 box, and plug the AC adapter into an appropriate 
electrical outlet.  

Step 2  Connect a USB cable between the upstream port of the USB hub under test and 
the USB port of the host PC.  

Step 3  Connect USB cables between the hub downstream ports and the UPT2 USB 
connectors, starting with the connector marked “CH1.” Do not skip any 
connectors on the UPT2. 

  
The CATC UPT2 external hub is now ready for testing.  

2.2 Installing the Software 
Step 1 Make a backup copy of the CATC application diskette. 
Step 2 Create a working directory (e.g. CATC_UPT2) on the hard drive of the PC under 

test. For example: 
C:>md CATC_UPT2 

Step 3 Switch to A drive 
C:>a: 

Step 4 Copy the contents of the CATC diskette to the working directory. 
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A:> copy *.* c:\CATC_UPT2 
Step 5 Switch to C drive and check the directory for the CATC UPT2 software files: 

UPT2.EXE  Executable code of the CATC UPT2 program 
README.TXT Text file containing useful information about UPT2 
TOP.RBF BusEngine code binary file 
UPT2FW4.HEX Firmware file for UPT2-4 
UPT2FW8.HEX Firmware file for UPT2-8 
A:>C: 
C:>cd CATC_UPT2 
C:\CATC_UPT2>dir 

2.3 Creating A Configuration File (UPT2.CFG) 
Prior to operating the UPT2 application, a test configuration file must be created to reflect the 
required test configuration. To do this, run the UPT2 application and use the UPT2 Configuration 
Screen to specify the configuration data. Refer to section “UPT2 Command Line Switches“ on 
how to start the UPT2 application and section “UPT2 User Interface Screens” on how to use the 
UPT2 screens to create the configuration file. To initially create a configuration file:  

Step 1 Start the UPT2 application without using any of the command line 
switches. 
C:>cd CATC_UPT2 
C:\CATC_UPT2>UPT2 

Step 2 Use the "File->View/Edit Configuration" option to show the UPT2 
Configuration Screen. It contains the default test configuration values 
built into the UPT2 application. 

Step 3 Change the test configuration parameter values by using the user 
interface described in section “Configuration Screen” to fit the required 
test environment. Exit the Configuration Screen back to the Main Screen. 

Step 4 From the Main Screen use the "File->Save Configuration" to save the 
configuration to the UPT2.CFG file. UPT2 always loads the test defined 
by UPT2.CFG when it is started from the DOS prompt. 
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2.4 Updating UPT2 Firmware 
The UPT2 box contains two firmware elements that might need updating as directed by 
CATC. CATC will provide two firmware files required for the update: 1) ASCII-hex file 
“upt2fw4.hex” for UPT2 - 4 or “upt2fw8.hex” for UPT2 - 8 and 2) binary file “top.rbf”. 
The firmware update instructions that follow are for updating both firmware elements in 
the UPT2 box. You might, however, update just one, depending on the request from 
CATC. The steps for updating the UPT2 firmware are: 

Step 1 Put installation diskette into A drive and set current director to A. 
Connect the UPT2 box to power and your USB port, and power-on the 
UPT2 box. 

Step 2 Execute command "upt2 /F” to update the UPT2 controller firmware. 
Check screen output in Test Detail pane to verify the download worked 
properly, and then exit UPT2 by pressing Esc key. 

Step 3 Execute command "upt2 /L" to update the UPT2 low speed BusEngine 
firmware. Check screen output in Test Detail pane to verify the 
download worked properly, and then exit UPT2 by pressing Esc key 

Step 4 Cycle the power on the UPT2 box, and check the behavior of the status 
LED. The firmware update is successful if the status light starts blinking 
rapidly almost immediately when power is applied. If the status light, at 
power-on, starts out with a slow blink and then starts blinking rapidly the 
firmware download failed, and you should contact CATC. 
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3 Operating the UPT2 Application 
Operating the UPT2 application involves starting the UTP 2.0 DOS based program (UPT2.EXE) 
with the UPT2 command as described in the section “UPT2 Command Line Switches,” and then 
using the user interface screens described in section “UPT2 User Interface Screens” to control the 
test, view test results and set up test configuration data. The test configuration file (UPT2.CFG) 
should be created as described in section “Creating A Configuration File” to reflect the test 
environment. Otherwise, tests might fail. 

3.1 UPT2 Command Line Switches 
Start the UPT2 application by executing the "UPT2" command at the DOS prompt. The default 
directory must be set to the directory containing UTP2.EXE. The UPT2 application command 
line switches are used to define the start-up functional options. The UPT2 command line switches 
are: 

UPT2 [/R[:n] or /F or /K or /L or /M:K or /X or /?] 
 

[/R[:n]] Start program and run test automatically, where n is the number 
of times to run test. To run test unlimited times, use /R:0. . “:n” 
can be set to any value between 1 and 32,000, e.g. /R:1000. 
When n is not specified, e.g. /R, the program will run the test one 
time. 

[/F] Update firmware controller. See section “Updating UPT2 
Firmware” for more information about using this switch. 

[/K] Enable USB keyboard support.  Default = disabled. 

Note: For USB keyboard support, after each test, UPT2 program will try to 
release USB control back to the BIOS. Due to insufficient documentation in the 
USB specification on this matter (i.e., the release of USB control from an 
application to the BIOS), this feature does not support EHC and OHC USB host 
controllers. It only supports SOME UHC USB host controllers.  

[/L] Update UPT2 low-speed BusEngine firmware. See section 
“Updating UPT2 Firmware” for more information about using 
this switch. 

[M:K] Reserves K*1024 bytes of storages for use by UPT2 as data 
transfer buffers. The default is 15. 

[/X] Operate in real mode addressing and use 0xD0000 as the base 
address for OHC and EHC controllers.  This was the default 
operating mode prior to UPT2 version 1.3.  Starting with UPT2 
version 1.3, the default is for UPT2 to operate in “flat mode” and 
use BIOS allocated operational base memory for EHC and OHC 
controllers. 

[/?] Display help message for command line usage. 
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3.2 UPT2 User Interface Screens 
When started as described in the previous section, the UPT2 application connects to the UPT2 
box and brings up the UPT2 Main Screen. The screen menus are used to run tests in several 
different modes, and to specify and view test configuration data. The UPT2 application can also 
be run by using the "/R:n" command line switch to run “n” tests immediately upon start up (See 
section “UPT2 Command Line Switches”). 

Tests are run for the connected ports based on the test configuration defined in the UPT2.CFG 
file (See section “Creating A Configuration File”). When a test configuration file is not present in 
the default directory, the default configuration built into the UPT2 application is applied. As the 
UPT2 application executes the tests, results are written to the Main Screen, and results are written 
to a log file. The log file name is based on the current date (mmddyy) and has an extension of 
".UPT", e.g., 100501.UPT. Furthermore, the UPT2 application lists information about the 
detected host controllers in the UPT2.CON file. 

The UPT2 application provides two DOS screens. A Main Screen that provides menus to execute 
application functions and view test results, and a Configuration Screen used for editing test 
configuration parameters. These screens are described below. 

3.2.1 Main Screen 
The Main Screen (Figure 3-1) is the first screen displayed when the UPT2 application is executed 
from the DOS prompt. The File pull down menu is shown in Figure 3.2 and is used to run tests 
and to setup and save test configuration data.  

The windowpanes show the test results as follows: 

Summary  (Left Pane) Lists for each port the number, controller type and 
pass or fail for each speed. The pane is updated as test progress 
for each port. The screen is scrollable using the PgUp and 
PgDn keys. 

Detail  (Right Pane) Test results and details are listed as the UPT2 
progresses through the port tests. This screen can be scrolled 
using the up and down arrows keys. 

Overall Result (Lower Left Pane) Displays the overall status of the test case. 
Displays “TESTING” during test execution, “PASSED” when 
all port tests complete without error, or displays “FAILED” 
when any individual port test fails. 

Status Bar (Bottom of window) The bottom border of the Main Screen 
displays error messages and a run count of the current test 
sequence. Errors are displayed on the left. The right side 
displays a count of executed tests. Three types of counts will 
display: Single Run - a one-time test run; #x - the number of 
tests (=x) that have been run in a sequence set to continue 
indefinitely or until an error occurs; and #x/y - the number of 
tests (=x) that have been run in a pre-specified set (=y). 

The Main Screen key controls are: 

Left/Right Arrows Move left and right between the File and Help menus. 
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Enter  Causes highlighted menu to pull-down the options menu, or 
when a menu is pulled down press Enter to execute the 
option. 

Up/Down Arrows  Once a menu is pulled down use the up and down arrows to 
move between the options. When a menu is not pulled down 
the up and down arrow keys are used to scroll the detail 
pane. 

PgUp/PgDn Scroll the Summary pane up or down. 

Esc Exit from a pull-down menu, or exit from the UPT2 
application 

Figure 3-1 UPT2 Main Screen 

 

3.2.1.1 File Pull Down Menu 
The File Pull Down menu (Figure 3-2) provides options associated with running tests, 
and establishing configuration data that customizes the UPT2 operation to fit the test 
requirements. The File Pull Down menu options are: 

Run Test (Single Run) Execute a single test run based on the current 
connections and the prevailing configuration data. 

Run Test… Pops up a dialog window (Figure 3-3) that allows 
the user to setup different run scenarios: 1) Run test 
until it fails or 2) Run test a specified number of 
time or until test fails or until Esc pressed. 

Load Configuration Load test configuration data from the UPT2.CFG 
file. The loaded configuration is now the prevailing 
configuration and is the basis for any executed test 
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cases. This provides a mechanism to “undo” 
configuration edits which have not been saved. 

Save Configuration Save the prevailing test configuration data to the 
UPT2.CFG file. 

View/Edit Configuration Activate the Configuration Screen to view or edit the 
prevailing test configuration data. Exiting the 
configuration screen does not automatically save the 
configuration data to file. You must use the "File->Save 
Configuration" option from the Main Screen. 

Quit Exit the UPT2 application and return to DOS. 
 

Figure 3-2 UPT2 File Pull Down Menu 

 
 

Figure 3-3 File->Run Test Dialog 
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3.2.1.2 Help Pull Down Menu 
The Help pull down menu (Figure 3-4) contains the About option that displays information about 
the installed version of the UPT2 application, firmware, low-speed BusEngine, and channels 
available. This information is useful when contacting CATC support. Figure 3-4 shows the Help-
>About display for an 8-port UPT2 device. 

Figure 3-4 Help->About Windows 

 

3.2.2 Configuration Screen 
The configuration screen shown in Figure 3-5 provides a user interface for changing test 
configuration parameters. The screen provides one-line help text at the bottom as each parameter 
is selected. The up and down arrow key are used to move between the parameter fields. The 
screen provides "list fields" for text values, "numeric fields" for number fields and "select fields" 
for on/off or "yes/no" values. These fields operate as follows: 

"list field" Press Enter to show the list, use the up/down arrows to 
move selection bar and PRESS ENTER to enter the 
current selection, and move to the next field. 

"numeric field" Type numbers and PRESS ENTER, up arrow or down 
arrow to enter the value and move to the next field. Use 
the left and right arrow to move within the numeric field 

"select field”  Use the left and right arrows to toggle between on "[x]" or 
off "[ ]" for a parameter setting. Press left/right arrow or 
Enter to accept the current setting and move to the next 
field. 

 

Use the "Esc" key to exit from the Configuration Screen. This does NOT save the configuration 
values. The test configuration values are saved from the Main Screen using the "File->Save 
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Configuration" menu option. The test configuration values shown by the Configuration Screen 
are applied to the next test run executed. 

3.2.2.1 Configuration Parameters 
Configuration parameters are provided on the Configuration Screen that might apply to later 
versions of the UPT2 product. Parameters that apply for this unit are highlighted on the 
Configuration Screen. The configuration parameters that apply to the unit are: 

Return to DOS Three settings for this parameter are No, Always, and 
PassOnly. Setting this parameter to No causes UPT2 to 
return to screen control after executing a test run.Setting 
this parameter to Always causes UPT2 to exit or return 
to DOS after completing a test run. Setting ths parameter 
to PassOnly Causes UPT2 to exit or return to DOS after 
executing a test that passed and returning to screen 
control after executing a test that fails. The After field of 
this parameter specifies the delay before returning to 
DOS.  Minimum value for this parameter is 100 ms. 

End of Test Sound Setting this parameter to "Yes" causes UPT2 to make a 
sound upon test completion. The sound is different 
depending whether the test passed or failed. A "No" 
setting results in UPT2 not making any sounds when a 
test completes. 

Log ASCII This parameter controls writing to a test results log file 
during test runs. See section “UTP2 Test Results Log 
File" for an explanation of this log file. The settings for 
this parameter are: “Detail" causes UPT2 to write 
summary and test detail data to the log file; “Summary” 
causes UPT2 to write the summary lines; “Disabled” 
results in no output to the log file; and, “FailureOnly” 
specifies to write detail data only when a test run fails. 

Connection Log Setting this parameter to “Yes” causes UPT2 to write 
host controller information into the Connection Log file, 
and setting the parameter to “No” disables this 
capability. See section “UPT2 Connection Log File” for 
information about this file. 

# Ports To Test Specify the number of ports to be tested. If the number 
of ports is more than the exact number, UPT2 can fail 
the test. If this happens, please go back and correct the 
port number for this prompt. 

High Speed Capable Select the UPT2 channels that are connected to high-
speed ports. An "x" signifies the channel is connected to 
a high-speed port. Note: Checking a channel as high 
speed when it is not connected to a high speed port will 
cause the UPT2 to designate the high-speed transfer test 
as failed. 
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Type of HC Select the type (UHC, OHC or EHC) of host controller 
to test. UPT2 automatically senses the host controllers 
present on the board, but will only test those selected. 

Memory Base This applies only to OHCI and EHCI host controllers, 
and when the /X command line switch is used.  The 
default without the /X option is for UPT2 to use BIOS 
allocated operational base memory for EHCI and OHCI 
host controllers, and employ 32-bit addressing using the 
flat memory model.   Specify the physical memory 
location for the on-board host controllers. This number 
is specified in hexadecimal. The OHCI or EHCI USB 
host controller needs 4K-system memory. When the /X 
command line switch is used, the UPT2 program maps 
this memory from d0000 to d7000.  If these memory 
areas are taken by other hardware in your PC, it can fail 
the UPT2 test. You must choose a different base address 
for UPT2 manually. They must be a non-cacheable 
system memory location. Possible address locations are 
C800 to E000. Specify the base address for the 
operational registers of the host controller. CATC is not 
responsible for finding an available base address in your 
system. Customers should work with their BIOS 
engineer to find an appropriate base address for UPT2 
testing. 

Transfer Test Select the type of data transfer test to be implemented 
for each port. The test types are bulk, interrupt and 
isochronous. The bulk test is ONLY good for full- and 
high-speed. 

VBUS Voltage Test Select, using an "x", implementation of the VBUS 
voltage test. Use the "Load" field to specify in milliamps 
the load to be placed on the VBUS line. The "Passed if" 
parameters give the greater than ">" and less than "<" 
voltage range for passing the test 

D+/D- Voltage Test Select, using an “x”, implementation of the D+/D- 
voltage test. Use the high and low values for idle and 
driven modes to specify acceptable ranges for passing 
the test. 

Over-Current Test Select, using an “x”, implementation of the hub over 
current test.  Set the Test Mode to “Automatic” to have 
UPT2 automatically increase the VBUS current draw 
until the hub detects an over current condition (or fails 
the test when maximum current draw is reached) and 
disconnects the UPT2 channel.  The automatic over-
current test steps the current from 100 milliamps to 5 
amps in 50 milliamp increments using a 50 millisecond 
interval.  Set Test Mode to “Regular” to draw current as 
specified by the “Value” parameter for a duration as 
specified by “Duration” parameter.  The “Protection 
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Mode” specifies the UPT2 method for verifying the hub 
produced the correct over current response.   
“Individual” signifies to verify that the hub reported over 
current on the correct individual port, “Global” signifies 
to verify that the hub reported an over-current as a 
summation across all ports.  “Descriptor” signifies to 
verify hub over-current reporting based on the method 
specified in the Hub Descriptor. 

Suspend/Resume Select, using an "x", implementation of the Port 
Test Suspend/Resume Test. This test sets the port under test 

to Suspend mode. It then sets the port under test to 
Resume mode. UPT2 then reads and verifies the number 
of Suspends/Resumes detected during the test. Test 
results are displayed as "Pass" or "Fail." 

Remote Wakeup Test Select, using an “x”, the type of hub remote wakeup test.  
Select “Device Generated” to test a hub’s handling of a 
resume signal from a connected device.  Select “Hub 
Generated” to test a hub’s ability to signal a remote 
wakeup, and select “Downstream Propagation” to verify 
a hub propagates resume to connected devices.  The 
“Downstream Propagation” must be set to perform the 
Power Switching test. 

Other Test Select, using an “x”, implementation of the Hub Power 
Switching test that verifies a hub’s ability to switch 
power on individual ports.  The hub’s power switching 
mode bits in the Hub Descriptor must be set for 
individual port power switching; otherwise, the Power 
Switching test is not run. 
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Figure 3-5 Configuration Screen UPT2 - 8 

 
 
  

3.3 UPT2 File Outputs 
The UPT2 application generates two files in the current directory when it starts up and as 
tests are executed. The two files are the Connection Log file and the test results log file. 

3.3.1 UPT2 Connection Log File (UPT2.CON) 
The UPT2 application on start-up detects the host controllers resident on the computer under test 
and generates a Connection Log text file describing each controller present. Figure 3-6 provides 
an example of a Connection Log file. The configuration parameter “Connection Log” is used to 
enable (“Yes”) or disable (“No”) this capability. The information shown for each host controller 
is: 

Hc Host controller type: UHCI for Universal Host Controller 
Interface, OHCI for Open Host Controller Interface and 
EHCI for Enhanced Host Controller Interface. 

VendorId Vendor identification code of the host controller. 

DeviceId Device identification code of the host controller 

IRQ Interrupt Request number used for the host controller. 

NumberOfPorts Number of host ports controlled by the Host Controller 

Base Address Base memory address used by the host controller.  
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Figure 3-6 Example Connection Log File 
Hc VendorId DeviceId IRQ NumberofPorts BaseAddress 
=============================================================== 
EHCI 1033  e0  b 5   d0000         
OHCI 1033  35  a 3   d1000         
OHCI 1033  35  b 2   d2000         
OHCI 1045  c861  b 2   d3000         
UHCI 8086  2442  b 2   N/A         
UHCI 8086  2444  9 2   N/A         
 

3.3.2 UPT2 Test Results Log File (“MMDDYY-2”.UPT) 
The UPT2 application provides the capability to capture in a text file test results for all testing 
conducted on a given day. Figure 3-7 shows an example test results log file generated for two test 
runs. The first two lines, called the summary, lists the number of units tested, number units 
passed, number units failed, and on the second line the time of the last test case for the day. 
Subsequent data, after the summary, gives a time tag for the start of a test run and then lists the 
test details. 

The name of the log file is “MMDDYY-2”.UPT, where MMDDYY represents the month (MM), 
day (DD) and year (YY) corresponding to the day the tests were conducted. 
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Figure 3-7 Example Test Results Log File 
Total # of Units Tested:        2  Passed:        2  Failed:        0 
Last test: 16:37:09 
 
Detail Log: 
============ 
 
 
12:36:45 Unit #1 
HC  1, PORT 1, SPEED HS, UPT2 CH 1 
  Connect                      Passed 
  Control transfer             Passed 
  Disconnect                   Passed 
  
HC  3, PORT 1, SPEED FS, UPT2 CH 1 
  Connect                      Passed 
  Control transfer             Passed 
  Disconnect                   Passed 
  
HC  3, PORT 1, SPEED LS, UPT2 CH 1 
  Connect                      Passed 
  Control transfer             Passed 
  Disconnect                   Passed 
 
 
12:37:10 Unit #2 
HC  1, PORT 1, SPEED HS, UPT2 CH 1 
  Connect                      Passed 
  Control transfer             Passed 
  Disconnect                   Passed 
  
HC  3, PORT 1, SPEED FS, UPT2 CH 1 
  Connect                      Passed 
  Control transfer             Passed 
  Disconnect                   Passed 
  
HC  3, PORT 1, SPEED LS, UPT2 CH 1 
  Connect                      Passed 
  Control transfer             Passed 
  Disconnect                   Passed 
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3.4 UPT2 Error Level Output 
UPT2 returns an exit code to DOS upon return from execution within a DOS batch file. DOS puts 
this code into the ERRORLEVEL parameter that can be checked by the batch file. When running 
UPT2 from a batch file the configuration parameter “Return To DOS” should be set to “Always” 
so UPT2 returns back to DOS once a run is completed. UPT2 returns a zero when the requested 
function or test executed without error, and returns a non-zero value when an error occurs. The 
UPT2 return codes are: 
0  – SUCCESS, UPT2 application accomplished requested function or test without error. 

1  – ERROR, invalid switch in UPT2 command line, no function or test conducted. 

2  – ERROR, UPT2 application was not able to detect PCI BIOS. 

3  – ERROR, UPT2 application was not able to allocate memory for test configuration data. 

4  – ERROR, UPT2 application was not able to allocate memory for generating test log file. 

5 – ERROR, UPT2 application was not able to allocate memory for data transfer. 

6 – ERROR, UPT2 application was not able to allocate memory for USB device data structures. 

7  – ERROR, UPT2 application was not able to detect a host controller. 

8  – ERROR, UPT2 application was not able to initialize at least one host controller. 

9  – ERROR, UPT2 application was not able to allocate memory for UPT2 object. 

10 – ERROR, UPT2 application conducted the specified test case and the test failed. 

11 – ERROR, UPT2 application was not able to allocate memory for USB host controller. 

12 – ERROR, UPT2 application was not able to allocate memory for USB hub object. 

13 – ERROR, UPT2 application failed to set CPU to 32-bit addressing mode (flat mode). 

The example below shows an example batch script for using the UPT2 to run a test and then 
printing success or failure of the run based on the ERRORLEVEL parameter. 

Figure 3-8 UPT2 Error Level Example 

:test1 

 

echo off 

UPT2 /r:1 

if errorlevel 1 goto test1_bad 

echo Test 1 Success! 

goto test2 

 

:test1_bad 

echo Test 1 Failed! 

 

:test2 
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3.5 Appendix: Setting BIOS Options and Using Config.sys File 
BIOS and memory options can affect the performance of UPT2. 

3.5.1 BIOS Settings 
If you enable Legacy device support and/or Plug and Play support, the UPT2 might fail to 
identify devices. If this happens, try disabling Legacy device and/or Plug and Play 
support. 
 
Furthermore, UPT2 uses, as default, BIOS allocated memory and 32-bit addressing for 
use with the EHCI and OHCI controllers.  This is not compatible with the Emm386 
application.  Use the /X command switch to revert to an application allocated memory 
pool and 16-bit addressing when using the Emm386 application.  Refer to the Memory 
Space configuration parameter described in the “Configuration Parameters” section. 
 

3.5.2 Config.sys Settings 
Emm386.exe and himem.sys might cause UPT2 to not function properly (for example, it 
might not identify USB host controllers because it does not have the memory it needs.) 
If you are using emm386.exe and himem.sys, you might need to exclude a range of 
memory addresses or manually assign memory addresses to UPT2. 
 


